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YASKAWA Electric Corporation  

High Speed Ethernet Server Driver   

 
 Supported version TOP Design Studio V1.4.2 or higher  

 

 

 

 

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 10 

 Describes how to set up communication for external devices. 

5. Supported addresses Page 11 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “YASKAWA Electric Corp. – High Speed Ethernet Server” is as follows: 

 

Series CPU Link I/F 
Communication 

method 

Communication 

setting 
Cable 

DX200 DX200 LAN port on the controller Ethernet (UDP) 
3. TOP 

communication 

setting 

4. External device 

setting 

Twisted pair  

Cable*Note 1) 

DX100 DX100 LAN port on the controller Ethernet (UDP) 

FS100 FS100 Ethernet port on the controller Ethernet (UDP) 

DX200 DX200 LAN port on the controller Ethernet (UDP) 

FS100L FS100L Ethernet port on the controller Ethernet (UDP) 

*Note 1) Twisted pair cable 

- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5. 

- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a 

direct cable. 

 

 

 

 

■ Connectable configuration 

 

ㆍ1:1 connection (one TOP and one external device) connection 

 

 

ㆍ1:N connection (one TOP and multiple external devices) connection 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Please select "YASKAWA Electric Corporation". 

PLC Select the external device to be connected to the TOP. 
 

Model Interface Protocol 

High Speed Ethernet Server Ethernet High Speed Ethernet Server 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Ethernet] 

– Set the TOP communication interface in TOP Design Studio. 

 
 

 

 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.255.50 192.168.255.1  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
 

 
The default IP for each series is as follows. 

– DX100, 200 Series: 192.168.255.1 

– FS100 Series: 10.0.0.2 

– Port number: 10040 
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(2) Communication option setting 

■ [Project > Project Property > Device Setting > ETHERNET > “PLC1 : High Speed Ethernet Server”] 

– Set the options of the High Speed Ethernet Server communication driver in TOP Design Studio. 
 

 

 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select “High Speed Ethernet Server”. 

IP Enter the IP address of the external device.  

Ethernet Protocol Select the Ethernet protocol between the TOP and an external device.  

Port Enter the Ethernet communication port number of an external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the 

main screen.  

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Ethernet] 
 

 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.255.50 192.168.255.1  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select “High Speed Ethernet Server”. 

IP Enter the IP address of the external device.  

Ethernet Protocol Select the Ethernet protocol between the TOP and an external device.  

Port Enter the Ethernet communication port number of an external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the ETH port settings you want to use in [Control Panel > Ethernet] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

Set as below using “Browser”. For more detailed setting method than that described in this example,  
refer to the PLC user manual. 

 
Do not use duplicate IP addresses over the same network. 

 

 

(2) External device setting 

Set as below using “YASKAWA MOTOMAN”. For more detailed setting method than that described in this example, refer to the 

YASKAWA user manual. 

Check the configured IP using the following method.  

- From “security mode”, change to “management mode”. 

- From the main menu, go to [SYSTEM INFO] -> [NETWORK SERVICE] to check the network settings.  
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5. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

■ Default system: Device & Address 

 

Device: 0070.00001.04.0000 

    Address 

    Attribute 

    Instance 

    Class 

 

Device Class Instance Attribute R/W Remarks 

Alarm 0x0070 1: The latest alarm 

2: The second alarm from the 

latest 

3: The third alarm from the latest 

4: The fourth alarm from the latest 

1: Alarm code 

2: Alarm data 

3: By alarm type 

4: Alarm occurring time 

5: Alarm character string name 

R  

Alarm History 0x0071 1~100 : Major failure 

1001~1100: Monitor alarm 

2001~2100: User alarm (system) 

3001~3100: User alarm (user) 

4001~4100: OFF line alarm 

1: Alarm code 

2: Alarm data 

3: Alarm type 

4: Alarm occurring time 

5: Alarm character strings name 

R  

Status 0x0072 Fixed to ‘1’ 1: Data 1 

2: Data 2 

R  

Job information 0x0073 1: Master task 

2: Sub task 1 

3: Sub task 2 

4: Sub task 3 

5: Sub task 4 

6: Sub task 5 

7: Sub task 6 

8: Sub task 7 

9: Sub task 8 

10: Sub task 9 

11: Sub task 10 

12: Sub task 11 

13: Sub task 12 

14: Sub task 13 

15: Sub task 14 

16: Sub task 15 

1: Job name 

2: Line number 

3: Step number 

4: Speed override value 

R  

Axis composition 0x0074 1 : R1~8 : R8 …Robot (pulse value) 

11 : B1~18 : B8 …Base (pulse value) 

21 : S1~44 : S24 …Station (pulse 

value) 

101 : R1~108 : R8 …Robot 

(cartesian coordinate) 

111 : B1~118 : B8 …Base 

(cartesian coordinate) 

1: “Axis name” of the first axis 

2: “Axis name” of the second axis 

3: “Axis name” of the third axis 

4: “Axis name” of the fourth axis 

5: “Axis name” of the fifth axis 

6: “Axis name” of the sixth axis 

7: “Axis name” of the seventh axis 

8: “Axis name” of the eighth axis 

R  

Robot Position 0x0075 1 : R1~8 : R8 … Robot (pulse value) 

11 : B1~18 : B8 … Base (pulse 

value) 

1: Data type 

2: Form 

3: Tool number 

R  
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Device Class Instance Attribute R/W Remarks 

21 : S1~44 : S24 … Station (pulse 

value) 

101 : R1~108 : R8 … Robot 

(cartesian coordinate 

4: User coordinate number 

5: Extended form 

6: First axis data 

7: Second axis data 

8: Third axis data 

9: Fourth axis data 

10: Fifth axis data 

11: Sixth axis data 

12: Seventh axis data 

13: Eighth axis data 

Each axis positional 

deflection 

0x0076 1 : R1~8 : R8 … Robot axis 

11 : B1~18 : B8 … Base axis 

21 : S1~44 : S24 … Station axis 

1: First axis data 

2: Second axis data 

3: Third axis data 

4: Fourth axis data 

5: Fifth axis data 

6: Sixth axis data 

7: Seventh axis data 

8: Eighth axis data 

R  

Each shaft torque 0x0077 1 : R1~8 : R8 … Robot axis 

11 : B1~18 : B8 … Base axis 

21 : S1~44 : S24 … Station axis 

1: First axis data 

2: Second axis data 

3: Third axis data 

4: Fourth axis data 

5: Fifth axis data 

6: Sixth axis data 

7: Seventh axis data 

8: Eighth axis data 

R  

IO Data 0x78 • 1~512 : Robot user input signal 

• 1001~1512: Robot user output 

signal 

• 2001~2512: External input signal 

• 2701~2956: Network input signal 

• 3001~3512: External output 

signal 

• 3701~3956: Network output 

signal 

• 4001~4160: Robot system input 

signal 

• 5001~5300: Robot system output 

signal 

• 6001~6064: Interface panel input 

signal 

• 7001~7999: Auxiliary relay signal 

• 8001~8128: Robot control status 

signal 

• 8201~8220: Pseudo input signal 

Fixed to “1”. R/W  

IO Data(Multi) 0x300 Fixed to “0”. R/W  

Register data 0x79 0~ 999 (writable register: 0 ~559) Fixed to “1”. R/W  

Register data(Multi) 0x301 Fixed to “0”. R/W  

B 0x7A 0~99 (for standard setting) Fixed to “1”. R/W  

B(Multi) 0x302 Fixed to “0”. R/W  

I 0x7B 0~99 (for standard setting) Fixed to “1”. R/W  

I(Multi) 0x303 Fixed to “0”. R/W  

D 0x7C 0~99 (for standard setting) Fixed to “1”. R/W  

D(Multi) 0x304 Fixed to “0”. R/W  

R 0x7D 0~99 (for standard setting) Fixed to “1”. R/W  
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Device Class Instance Attribute R/W Remarks 

R(Multi) 0x305 Fixed to “0”. R/W  

S 16 byte 0x7E 0~99 (for standard setting) Fixed to “1”. R/W  

S 16 byte(Multi) 0x306 Fixed to “0”. R/W  

P 0x7F 0~127 (for standard setting) 1: Data type 

2: Form 

3: Tool number 

4: User coordinate number 

5: Extended form 

6: “Coordinated data” of the first 

axis 

7: “Coordinated data” of the 

second axis 

8: “Coordinated data” of the third 

axis 

9: “Coordinated data” of the 

fourth axis 

10: “Coordinated data” of the 

fifth axis 

11: “Coordinated data” of the 

sixth axis 

12: “Coordinated data” of the 

seventh axis 

13: “Coordinated data” of the 

eighth axis 

R/W  

P(Multi) 0x307 Fixed to “0”. R/W  

BP 0x80 0~127 (for standard setting) 1: Data type 

2: “Coordinated data” of the first 

axis 

3: “Coordinated data” of the 

second axis 

4: “Coordinated data” of the third 

axis 

5: “Coordinated data” of the 

fourth axis 

6: “Coordinated data” of the fifth 

axis 

7: “Coordinated data” of the sixth 

axis 

8: “Coordinated data” of the 

seventh axis 

9: “Coordinated data” of the 

eighth axis 

R/W  

BP(Multi) 0x308 Fixed to “0”. R/W  

EX 0x81 0~127 (for standard setting) 1: Data type 

2: “Coordinated data” of the first 

axis 

3: “Coordinated data” of the 

second axis 

4: “Coordinated data” of the third 

axis 

5: “Coordinated data” of the 

fourth axis 

6: “Coordinated data” of the fifth 

axis 

R/W  
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Device Class Instance Attribute R/W Remarks 

7: “Coordinated data” of the sixth 

axis 

8: “Coordinated data” of the 

seventh axis 

9: “Coordinated data” of the 

eighth axis 

EX(Multi) 0x309  Fixed to “0”. R/W  

Alarm (detailed) 0x30A 1: The latest alarm 

2: The second alarm from the 

latest 

3: The third alarm from the latest 

4: The fourth alarm from the 

latest 

1: Alarm code 

2: Alarm data 

3: By alarm type 

4: Alarm occurring time 

5: Alarm character string name 

6: Sub code data additional 

information character strings 

7:Sub code data character strings 

8:Sub code data character strings 

reverse display information 

R  

Alarm history (detailed) 0x30B 1~100 : Major failure 

1001~1100: Monitor alarm 

2001~2100: User alarm (system) 

3001~3100: User alarm (user) 

4001~4100: OFF line alarm 

1:Alarm code 

2:Alarm data 

3:Alarm type 

4:Alarm occurring time 

5:Alarm character strings name 

6:Sub code data additional 

information character strings 

7:Sub code data character strings 

8:Sub code data character strings 

reverse display information 

R  

Reset cancellation 0x0082 1: Resetting of alarm 

2: Cancelling of error 

Fixed to “1”. W  

On/off 0x0083 1: HOLD 

2: Servo ON 

3: HLOCK 

Fixed to “1”. W  

Start switch 0x0084 2: CYCLE (switching of 

STEP/CYCLE/CONTINUE) 

Fixed to “1”. W  

Sting display to pendant 0x0085 Fixed to “1”. Fixed to “1”. W  

Start 0x0086 Fixed to “1”. Fixed to “1”. W  

Job select 0x0087 1: Set the executing job 

10: Set the master job (task 0) 

11: Set the master job (task 1) 

12: Set the master job (task 2) 

13: Set the master job (task 3) 

14: Set the master job (task 4) 

15: Set the master job (task 5) 

16: Set the master job (task 6) 

17: Set the master job (task 7) 

18: Set the master job (task 8) 

19: Set the master job (task 9) 

20: Set the master job (task 10) 

21: Set the master job (task 11) 

22: Set the master job (task 12) 

23: Set the master job (task 13) 

24: Set the master job (task 14) 

25: Set the master job (task 15) 

1: Job name 

2: Line number (valid only when 

executing job setting.) 

W  

Administration Hour 0x0088 1 :Control power ON time 1: Operation start time R  
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Device Class Instance Attribute R/W Remarks 

10 :Servo power ON time (TOTAL) 

11~18 :Servo power ON time (R1 

to R8) 

21~ 44 :Servo power ON time 

(S1~S24) 

110 :Play back time (TOTAL) 

111~118 :Play back time (R1~ R8) 

121~144 :Play back time (S1~S24) 

210 :Motion time (TOTAL) 

211~218 :Motion time (R1~R8) 

221~244 :Motion time (S1~S24) 

301~308 :Operation time 

(application 1~ 8) 

2: Elapse time 

System information 0x0089 11~18: Type information (R1~R8) 

21~44: Type information (S1~24) 

101~108: Application information 

(application 1~8) 

1: System software version 

2: Model name / application 

3: Parameter version 

R  

S 32 byte 0x8E 0~99 (for standard setting) Fixed to “1”. R/W  

S 32 byte(Multi) 0x30C Fixed to “0”. R/W  

 

 


